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Introduction

This book presents a series of tutorials developed to teach
you how to create stunning AeroLog Pro reports . The
tutorials begin with the basics, such as how to use the
Report Designer, and ends with advanced reporting
techniques using multiple sub-reports. This guide should
therefore be helpful to both the novice and the seasoned
report-builder.
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DESIGN

The Report Designer, pictured above, is the tool you will
use to build reports. It contains three workspaces: Data,
Design, and Preview. When first displayed, the Report
Designer defaults to the design workspace because this is
where you will spend the majority of your report-building
time. The design workspace is divided into two areas: the
workbench and the canvas. The workbench is comprised
of toolbars, component palettes, rulers, and other tools
that can be used to manipulate the canvas. The canvas is
the area that contains the report layout. This is where we
place the bands and components that will ultimately
control the content of each page of the report.

PREVIEW

The preview tab plays an integral role in the report-
creation process because it allows you to see how the
report will look when printed. As you work through the
tutorials, you'll notice that this workspace is frequently
accessed so that we can see how the report is shaping up.
We will make many changes and corrections based on
what we see in this workspace. The tools in this space
allow you to view each page of the report or zoom in to

get a better look at a specific page. You can also print the
report from the preview workspace.

DATA

The data workspace is often the key to successful report
creation because it allows us to select and manipulate the
data needed for a given report. These tasks are
accomplished via two visual tools: the Query Wizard and
the Query Designer. These tools greatly simplify the
often-difficult task of data selection by giving us the
ability to select data without requiring an in-depth
knowledge of databases.

Once the data is selected, we can begin laying out the
report. The primary purpose of a report is to transform
raw data into information. Our task as report-builders is
essentially to make data meaningful. The following
tutorials will show you how to do just that.

ABOUT THIS BOOK

As you work through this guide, it is important to keep in
mind that the tutorials build on one another, moving from
basic concepts to complex reports. Therefore, it may be
difficult to complete an advanced tutorial without having
first completed earlier tutorials. Each tutorial produces
some kind of report and brings to light important aspects
of ReportBuilder.

* A Quick Test Spin gives you a glimpse of the Report
Designer's report-building potential.

»  Calisthenics offers a series of exercises that prepare
you for the tutorials. You will be a nimble user when
you complete the calisthenics.

*  The Summary Tutorial concentrates all that you
learned in Calisthenics into a report. Like the
tutorials that follow, it gives you an opportunity to
use all the tricks you learned in Calisthenics.

*  The Cover Page tutorial illustrates the ease with
which you can design a cover page so that the report
looks clean and professional.

*  The Simple Table Listing tutorial shows you how to
build a report using the Report Wizard and
introduces “joined-tables” datasets, and some ways to
handle repeating data.

»  The Flights Grouped by Aircraft tutorial illustrates



how to create a flight listing which is grouped and
sub-totaled by aircraft. It also illustrates how to
import and use a saved DataView



A Quick Test Spin

OVERVIEW

This simple exercise provides an introduction to the
Report Designer, the Query Wizard, and the process of
building reports. The purpose of this tutorial is to show
you what it takes to build a report, so if this exercise starts
to feel a little over your head, don't worry. We will cover
the meaning behind the actions in later tutorials. The final
report for this tutorial should contain a list of flights
including:

*  The departure date of each flight

*  The route of each flight (From, To & Via)

*  The flight duration (block-time) for each flight

Departure Date Route Duration
ar27M1984 FATHETTR 0:30
10/05/1984 FATHETTH 1:00
1011211984 FATMETT 112
10M7M1984 FATMKTTN 1:06
10/26/1 984 FATHETTR 1:00
10/28/1984 FATHETTH 0:36
11/06/1984 FATMETT 1:00
1110951 984 FATMKTTN 1:00
11161984 KT KT 0:54
1111971984 FATHETTH 1:00
11f23/11984 FATHMKTTH 1:06
1112711984 FATMKTTN 0:64
11130/ 984 FATHETTM 1:06
12108/1984 FATHETTH 0:54
12M10/1984 FATHMKTTH 0:64
1212211984 FATMETTM 0:64
1212411984 FATHETTM 1:06
001985 KA KTT 0:54
01/19/19845 FATHTT 0:48

Note: If this tutorial seems too difficult, proceed to
Calisthenics and go through it first, then return to this
tutorial.

GETTING STARTED

It will be helpful for you to become familiar with the

following set of directions because you'll repeat this

process to begin each report.

»  Start AeroLog Pro and click the Custom Reports
button.

*  Click the New Report& button in the navigator

bar.

*  Click on the Data tab.

*  Select [File[New] in to open the New Items dialog.

*  Double-click on the Query Wizard icon. The Query
Wizard will come up with a list of available tables.

QUERY WIZARD

The Query Wizard is a tool that allows you to access

information from your database to use in your report.

*  Choose the PilotLog table by double-clicking on it.
Confirm your selection by verifying that the table
name appears in the Selected Tables list.

*  Click the Next button. Keep clicking Next until you
reach the Set Order page.

*  Click on the Set Order button.

*  Double-click on PilotLog.Dep_Date so it appears in
the Selected Fields list.

e Click Next.

* A screen with a checkered racing flag will appear.
Select the Preview radio button near the bottom, then
click Finish. A Data Preview screen will appear
listing information from the PilotLog table.

*  When you're finished looking at the Preview screen,
click OK.

*  You've officially completed your first query via the
Query Wizard. You'll notice a new window in the
upper left-hand corner of the data workspace. This is
the dataset you just created. It represents the data,
which is selected from the database each time the
report is generated.

*  Click on the Design tab to begin laying out your
report.

DESIGN WORKSPACE

The design workspace is the environment in which you
will build reports. Whatever you put in the header band
(the white space above the word “Header”) will appear at
the top of each page of the report; whatever you put in the
detail band will be the body of the report, and whatever
you put in the footer band will appear at the bottom of

each page of the report.

Task 1: Place and name labels

¢ Locate the Label button i on the toolbar.



e Click on the Label button, then click in the white
space of the header band to add a new Label
component.

*  Repeat the above to add two more Labels in the
header band.

*  Select the Labell component by clicking once on it.
Locate the edit toolbar (below the Label component
button on the toolbar). It should contain the text
“Labell", which is the caption of the currently
selected label.

*  Highlight the text in the edit toolbar and type
“Departure Date”.
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*  Select Label2 and type “Route” into the edit toolbar.
*  Select Label3 and type “Duration” into the edit
toolbar.

Task 2: Save the report
*  Press Ctrl-S to save your work. A dialog box will
appear that looks like this:

Save Mew Report As

Savejr o8 Al Folders

[ Completed Tutarials
D Logbook:s
(A Summary Reports

Name Mew Report Save

[ see |
Cancel |

*  Expand the drop-down list at the top of this dialog by
clicking on the arrow icon. Select “All Folders” from
the list. This will allow us to save the report in this
folder.

* At the bottom of the dialog you should see an edit
box that contains the report name. The default name
is “New Report.” Select the text and change the name
to “Quick Test Spin.” Click the Save button.

*  Close the Report Designer window. Notice that your
new report is listed in “All Folders.”

*  Select Quick Test Spin by clicking once on it, then
click the Open Report button to return to the design
workspace.

Task 3: Bold the Text in the Labels

*  Select the Departure Date label.

*  Hold down the <Shift> key and then click on the
other two labels components. All three labels should
now be selected. You can tell that they are selected
by the small gray boxes surrounding each label.
These boxes are called selection handles.

Ueparture Date! Houte!

* Header

Uuration!

*  Click the Bold button i in the toolbar. All three
label captions should change to boldface type.

Task 4: Create DBText components

¢ Locate the DBText button E on the toolbar.

*  Place a DBText component in the detail band.

*  Change the text from bold to regular by clicking the
Bold button.

*  Place two more DBText components in the detail
band.

*  Select DBTextl. Notice that there are two drop-down
list boxes in edit toolbar. The drop-down list box on
the left contains the dataset from the data workspace
. The drop-down on the right contains the fields.

*  Select “Dep Date” from the drop-down list box on
the right. The first date in the dataset should appear
as the caption of the DBTextl component. If not,
pull down the View menu and select Show Data, the
re-select “Dep Date” from the fields list.
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* Right-click on DBTextl (Dep Date) to show the
options menu, then select AutoSize.



¢ Select DBText2 and choose “Route” from the fields
list.

*  Right-click on DBText2 (Route) and select AutoSize.

*  Select DBText3 and choose “Block Time” from the
list.

*  Right-click on DBText3 (Block Time) and select
ElapsedTimeFormat.

*  With DBText3 still selected, click on the Right

in the toolbar.

Justify button

Task 5: Position the Label components

*  Right-click over the Departure Date label and select
the Position... menu option.

e Set Leftto 0.1 and Top to 0.3

* Right-click over the Route label and, in a similar
fashion, set Left to 1.3.

*  Set Left to 3.1 for the Duration label.

*  Select the Departure Date label.

*  Hold down the <Shift> key and click on the other
two labels. All three labels should now be selected.

«  Click the Align Top button _"0_ in the toolbar. The
top edges of all three labels should now be aligned.

Task 6: Adjust the DBText Components
* Right-click over the Dep Date DBText component.

*  Select Position... from the menu then set Top to 0.03.

*  Select the the Dep Date DBText component.
»  Shift-click the other DBTexts so that they are all
selected.

*  Click the Align Top button I i the toolbar.
Task 7: Align the components

*  Select the Departure Date Label, then shift-click the
Dep Date DBText.

*  Click the Align Middle button i in the toolbar.

The DBText component should be centered directly
beneath the Label component.

¢ Select the Route Label, then shift-click the Route
DBText.

*  Click the Align Left button I_E' in the toolbar.

e Left align the Duration Label and the Block Time
DBText in a similar fashion

*  Press <Ctrl-S> to save your work.

PREVIEW

The preview window in the Report Designer environment
works the same way as the preview function in other
Windows applications: it shows you how your report will
look when it is printed.

Click on the Preview tab and look at your report. Make
sure that the columns are spaced evenly with plenty of
room for long route lists.

Everything should look good except for the rows, which
are double-spaced. That spacing takes up too much room
and will waste paper when the report is printed.

FIXES

*  When you preview a report, you'll undoubtedly find
something that can be improved. Let's fix the
spacing.

*  Return to the design workspace by clicking on the
Design tab.

*  Place the mouse cursor over the gray bar labeled
“Detail”. The mouse cursor will change to an
up/down arrow, indicating that you can drag the
section divider up and down.

*  Drag the divider up until it meets the bottom of the
components in the detail band.

*  Preview the report once more. It should look like the
report shown on the next page

*  Close the Report Designer window by clicking the
button at the upper right corner of the window. A
dialog box asking you to “Save Changes” will
appear. Click Yes.

Congratulations! You've completed your first AeroLog
Pro report.
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Departure Date  Route Duration
09271984 KATH, KITH 0:30
104051984 KATH, KITH 1:00
10121984 KATH, KITH 1:12
10A171984 KATH, KITH 1:06
104261984 KATH KITH 1:00
104281984 KATH, KITH D36
114061984 KATH, KITH 1:00
114091984 KATH, KITH 1:00
11161984 KATH, KITH 0:54
1141971984 KATH, KITH 1:00
114231984 KATH, KITH 1:06
114271984 KATH, KITH 0:54
1153001984 KATH, KITH 1:06
120201924 EA7H KITH 0:54
1241001984 KATH, KITH 0:54
124221984 KATH, KITH 0:54
1242401984 KATH, KITH 1:06
0141001985 KATH, KITH 0:54
011941985 KATH, KITH D48
02041985 KATH, KNG, KITH 1:12
02101985 KATH, KBV KITH 1:12
02141985 KATH, KITH 0:30
024201985 KESM KI1TH 1:06
D2F20/1985 KT, KESH 1:00
03011985 KBLM, KITH D2
03011985 KATH, KB L 1:00
03131985 KATH, KITH D36
03161985 KATH, KILG, KITH 1:18
D3F26/1985 KATH, KITH 0:30 -
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Calisthenics

OVERVIEW

These exercises will get you oriented in the Report
Designer environment and teach you to use some basic
tools. It's a good idea to study this section because each
task is extremely detailed, whereas the other exercises
will assume that you are familiar with the basics and

therefore be less explicit.

COMPONENT CREATION

The first thing you need to know in order to write a report
is the significance of the canvas. The canvas is divided
into sections called bands. A band is labeled in the
section divider immediately below it; thus, the first band
is called “header”, the second is called “detail”, and the
third is called “footer”. When the report generates, the
bands are printed on different parts of the page. There are
many different band types for different occasions, but for
now we'll just use the header, detail, and footer bands.

Let's create some components and put them in the bands.

A component is an element used to control how the report

looks. Each component has a unique purpose.

»  Start AeroLog Pro and click the Custom Reports
button.

*  Click the New Report button E in the navigator
bar. The Report Designer will appear with the design

workspace active.

¢ Locate the Label button i on the toolbar.

¢ Click on the Label button, then click in the white
space of the header band. You've just created a Label
component.

*  Create two more Labels in the header band.

by
*  Locate the Shape button & 011 the toolbar.

*  Click the Shape button, then click in the white space
of the header band to create a new Shape.

*  Press <Ctrl-S> to save your work. Name the report
“Cal-1". Remember to save your work at the end of

each task.

“ Header

[Labell] |Labeld [Labed |
—a—h

Note: You can use the process of clicking a component
button in the toolbar, then clicking in a band to create

any type of component.

BAND ADJUSTMENT

Notice that the Shape doesn't quite fit in the header band.

We can remedy this by increasing the height of the band.

*  Locate the ruler on the left side of the workspace.

*  Place the mouse cursor over the divider (gray bar)
labeled “Header”. The mouse cursor will change to
an up/down arrow, indicating that you can drag the
divider up and down.

*  Hold down the left mouse button and drag the divider
up and down. Notice the two little lines that appear
on the vertical ruler to the left of the divider. These
lines are called guides because they represent the new
position of the divider.

* Increase the height of the header band by dragging
the divider until the guide reaches the one inch mark
on the vertical ruler. In order to do this you must first
drag the divider until the band height is greater than
one inch. Then release and drag the divider up until
the top guide hits the one inch mark.

Note: This method of changing the size of the header
band works for all bands.



BASIC COMPONENT SELECTION

Once components are created, the real work begins, for

each component needs to be carefully positioned in order

to create a high-quality report.

*  Select the Labell component by clicking on it. The
selected label should look like this:

JEER

*  Select the remaining components. To do this, hold
down the <Shift> key and then click on the Label2,
Lable3, and Shape components. All of the

components should now be selected. You can tell that
they are selected by the small gray boxes surrounding
each component. These boxes are called selection

handles.

*  Click anywhere on the white space in the header

U_ghelt U_aheld 1_ghelz

band. Notice that the components are deselected.

*  Click on the white space to the left of the first label,
hold down the left mouse button, and begin dragging
the mouse down. A dashed-line rectangle will be
drawn from the point you first pressed the mouse
button and will change size and shape as you drag.
This rectangle is called a bounding box.

*  Drag the mouse across the band until the bounding
box encloses all four of the components, then release
the button. All of the components within the box will
be selected.

*  Place the mouse cursor over one of the components
and drag in any direction. Notice how all of the
components move in unison. This is called a

component selection.

Note: These are the two methods you can use to select
multiple components: the shift-click method (hold down
the <Shift> key and click the components) and the

bounding box method (hold down the mouse button and

outline the components).

SIZING, ALIGNING, AND POSITIONING
COMPONENTS

In order to get all of the components lined up neatly or
sized correctly, you must know how to size and align with
dexterity.

Sizing
*  Deselect all components by clicking anywhere in the
white space of the header band.

*  Select the shape component in the header band.

*  Place the mouse cursor over the little black box on
the right side of the Shape component and wait until
the cursor changes to a left/right arrow. The little
black boxes that surround the shape are called sizing
handles.

*  Drag the cursor to the right and notice how the Shape
gets wider.

*  Place the mouse cursor over the sizing handle on the
bottom of the shape and wait for the cursor to change
to an up/down arrow.

i

*  Drag the cursor down and notice how the Shape gets

taller.

g



Place the mouse cursor over the sizing handle on the
right-hand corner of the Shape and wait for the
cursor to change to a diagonal arrow.

Drag the cursor. The Shape gets both wider and
taller.

Drag the Shape to the left the corner of the header
band.

Move the shape up and down in the header band.
Notice the guides on the vertical and horizontal
rulers. Whenever you are dragging or sizing, the
guides show you the position and size of the

selection.

* Header

Use the guides to set the Shape to 2 inch by 2 inch.
The guides should match up with the % inch mark on
both the horizontal and vertical rulers.

Note: You can also adjust the size of a component by

selecting the component, then holding down the <Shift>

key and pressing the arrow keys. You can use this method

to size single and multiple component selections.

Aligning

Select the Shape component in the header band.
Hold down the <Shift> key and then click on the
three Label components. All four components should
now be selected.

Click the Align Top button I i the toolbar. The

Labels should align with the Shape.
Move Label3 to the bottom of the header band.

pl L

a Labell Label

Label3

* Header

Select Label3 and shift-click the other components in
order to add them to the selection.

Click the Align Bottom button E The components
should align with Label3.

Note: The first component selected in a multi-select is the

one to which the others align.

Positioning

Deselect the components by clicking in the header
band white space.

Select the Shape component.

Hold down the <Ctrl> key and press the up arrow
key several times to move the component.

As you move the Shape using this method, look at the
status bar in the lower right-hand corner of the
Report Designer. The Top measurement should track
with the component's location.

|Left: @ [Top: 0.0625 [wliclth: 0.5 [Height: 0.5

Use the right arrow key to move the Shape
component to the right. The Left measurement should
track with the component's location.

Position the Shape component so that Left is 0 and
Top is 0.0625

Deselect the Shape component.

Use the shift-click method to select the Label
components.

Using the arrow keys, position the selection at Left =
1.3021 and Top = 0.3854.
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FRONT-TO-BACK ORDER
This section illustrates how a component can be used as a
background for other components.

Task 1: Create and Color Shapes

*  Create two more Shape components near the existing
one in the header band.

*  Select the first Shape component.

& -
¢ Locate the Fill Color button —I—I in the toolbar.

*  Click the down arrow to the right of the button. The
Fill Color palette will be displayed. Select yellow.

| Mo Fill |
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*  Select the second shape.
*  Set the color to aqua.

*  Select the third shape.

*  Set the color to purple.

Task 2 : Overlap shapes and establish their order.

*  Position the aqua Shape component so that its corner
overlaps the corner of the yellow one.

»  Position the purple Shape component so that its
corner overlaps the corner of the aqua one. The three
shapes should look like this:

*  Select the Preview tab. Notice that the shapes retain
their front-to-back ordering.

*  Return to the design workspace and right-click over
the purple Shape component.

*  Select the Send to Back menu option. Notice how the
purple shape is now behind the aqua shape.

*  Right-click over the purple Shape component.

*  Select the Bring to Front menu option. The purple
shape is once again in front of the aqua shape.

* Right-click over the yellow shape.

*  Select the Bring to Front menu option. The yellow
shape is now in front of the other two shapes.

*  Restore the original order of the shapes by deciding
which shape needs to be sent to the back or brought
to the front. (Answer: Send the yellow shape to the
back.)

Task 3: Use a shape as a background

*  Right-click over the yellow shape.

*  Select the ParentHeight menu option. The shape's
height increases to match the band's height.

*  Select ParentWidth. The shape's width increases to
match the band's width. The other components appear
in front of the shape because of the front-to-back
order.

*  Right-click over the yellow shape.

*  Select the Bring to Front menu option. Notice how
all of the components disappear from view.

*  Make the components reappear by right-clicking over
the yellow shape and selecting the Send to Back

menu option.

Note: Whenever you appear to have lost a component, try
using the Send to Back method in order to find it. It may

be behind another component.
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ADVANCED COMPONENT SELECTION

This section explains how to select components in the

foreground when you have a larger component in the

background.

* Try to select all of the components in the header band
by clicking to the left of the first component, holding
down the left mouse button, and dragging the mouse
(i.e. the bounding box method). Notice how the
components cannot be selected. This is because the
yellow shape, which is sized to fill the entire header
band, is selected and no bounding box can be drawn.

*  Hold down the <Ctrl> key and try to select the
components using the bounding-box method again.
When the <Ctrl> key is held down, you will see a
bounding box.

: 1 Cabel]  [Labeld: [Cabed

*  Expand the bounding box to encompass all of the
components and release the mouse button. All of the
components, including the yellow shape, should be
selected.

n_ghe|n _gbelr  U_ghel-

*  Try to move the selected components. Notice how
they appear to be locked in place. The selection
cannot be moved because the yellow shape fills the
band and has no where to go.

*  Hold down the <Shift> key and click the yellow
shape.

Note: You can use the shift-click method to deselect any

component that is part of a multi-selection.

*  Move the selected components. The components can
be moved now because the yellow shape is
deselected.

*  Try to deselect the components by clicking on
Labell. Nothing happens. That's because you must
select an unselected component or click in the white

space of a band in order to clear the current selection.

*  Deselect the components by clicking on the yellow

shape.

ADVANCED SIZING

When you have a shape stretched using ParentWidth and

ParentHeight, you cannot change the size via the sizing

handles. This exercise shows you how to resize such a

shape.

*  Place the mouse cursor over the sizing handle on the
left side of the yellow shape. The left/right arrow will
be displayed.

*  Try to reduce the size of the shape by dragging the
cursor toward the center of the header band. The
shape can't be modified because it is set to
ParentWidth.

*  Right-click over the shape.

*  Select ParentWidth. The ParentWidth menu option is
deselected. Now the shape's width can be modified

using the sizing handle.
»  Select ParentHeight. The ParentHeight menu option

is deselected. Now the shape's height can be modified
using the sizing handles.

»  Use the sizing handles to modify the yellow shape so
that it is about the same size as the other shapes.

Note: You may not be able to resize the shape so that it is
exactly the same size as the others. The next section will
address this issue by showing you a more precise way to

resize shapes.

COMPONENT OPTION MENU

The component option menu appears when you
right-click over a component. It offers different options
for altering the overall look of your component via
changes in shape, size, and visibility. The component
option menu for a Shape is shown below.
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Ering ko Fronk
Send to Back.

ParentHeight

Parentywidth

Position, ..

ReprintonowerFlow

ShiftWwithParent

StretchiyitbhParent
v Yisible

So far, the tutorials have introduced the following menu

options: Bring to Front, Send to Back, ParentHeight, and
ParentWidth. Next, we'll learn about the Position...

option, which allows you to control the size and position

of components more precisely.

Task 1: Set shape sizes

Select the labels and move them to the left until they
reach a left of 3.7396 as indicated by the status bar.
Access the component option menu by right-clicking
over the yellow shape.

Select Position... . A dialog box like the one below
will be displayed; however, the numbers may be
slightly different from these. That's fine.

ok,

Cancel

Height 0.5

Apply

ik

Set Left to 2.0, Top to 0.2, Width to 0.5, and Height
to 0.5.
Click OK to close the Position dialog.

Task 2: Resize the aqua shape

Right-click over the aqua shape to access the
component option menu, then select Position... .

Set Left to 3.0, Top to 0.2, Width to 0.5, and Height
to 0.5. The aqua shape should now be the same size
as the yellow shape.

[f

Select Position... for the purple shape, then set Left to
1.0 and Top to 0.3. The layout should look similar to
the following:

4

Label3
Labell
Lahel

Note: The component option menu applies only to the

component over which you have right clicked, regardless
of the selection. Task 3 will illustrate this.

Task 3: Component properties and the option menu.

Select the aqua shape.

Shift-click the other two shapes in order to add them
to the selection.

Right-click over the aqua shape.

Select Position..., set Top to 0.1 then click OK.
Notice that even though the other shapes are selected,
the aqua shape is the only component that moves.
That's because the aqua shape was the one over
which we right-clicked.

Right-click over the purple shape.

Select Position... and set Top to 0.2.
Right-click over the yellow shape.

Select Position... and set Top to 0.3. The shapes
should now look like this:

Right-click once again over the aqua shape and set

the Top position to 0.0.
Click the Align Top button 0T Al shapes should

align with the top of the aqua shape because it was
selected first.
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Note: You can use this method whenever you need to set
the size or position of several components to the same

value.

Task 4: Save your work
e Select [File|Save] from the main menu.

Iﬁ Edit Wiew Report Help
Mew. ..
Mew Report
Cpen...
Close

Save 4s.,,

Load Fraom File. ..
Save ko File. ..

Page Setup...
Prink

Print ko File Setup...

*  Close the Report Designer.

DATA TREE
The Data Tree allows you to build a report based on data
you have selected from the database. In order to use the

Data Tree, you must first select data by creating a dataset.

Task 1: Create a new report
»  Start AeroLog Pro and click the Custom Reports
button.

*  Click the New Report button Q in the navigator

bar. The Report Designer will appear with the design
workspace active.

*  Click on the Data tab.

*  Select [File[New] to access the New Items dialog.

*  Double-click on the Query Wizard icon.

Task 2: Create a Dataset via the Query Wizard

*  Choose the Class table by double-clicking on it. The
Class table should now appear in the Selected Tables
list.

*  Click the Next button six times until you reach the
screen with the checkered racing flag.

*  Click on “Preview the query”, then click Finish. A
preview data screen with the information from the
database should appear.

*  When you're finished looking at the preview data
screen, click OK.

*  You'll notice a new window in the upper left-hand
corner of the data workspace. This is the new dataset
It represents the data that will be selected from the
database each time the report is generated. In a later
exercise, we will show you how to make
modifications to a dataset. For now, let's move on to

building the report.

Dats |I:ah: | Design | Preview |

&I[ﬁ]ﬁﬁ‘i%%l

M ame | Type | Size |
Clas= String 3

D escription String 20
Locked Boolean

Task 3: Dock the Data Tree

*  Click on the Design tab.

*  Maximize the Report Designer window.

*  Select [View|Toolbars|Data Tree] from the menu.

*  Click on the title bar of the Data Tree and drag it to
the left, making sure that the toolbar is below the
horizontal ruler. Continue dragging until the mouse
pointer is in the left margin of the designer window,
and the position rectangle changes froma heavy
outline to a thin dotted one.

*  Release the mouse button. The Data Tree should
dock on the left of the workspace as shown in the
figure below.
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[ ata I Cale Design | F"rex-'iewl

KA E 3oy @ &g

—

Il (e
|8 8 |aown |8 &6 =a|e
R
...... Class o
" Header
Figlds for Class =
Mame | Type | Size | I
Al Clazs String 3 e Detal
[Hl Description  Sking 20 o
CH] Locked Boole... [
"~ Footer

Data I L apout I

Task 4: Create a vertical report

*  Click on the Layout tab at the bottom of the Data
Tree.

*  Pull down the Style control and select “Vertical”.

— Create Shyle

e Al

—{" Labels
[ Gri
—{" Fields
[T Gnd Font A

Company
Action Club

Campany  Action Clubk

Data  Layout |

*  Click on the Data tab at the bottom of the Data Tree.

*  Click the “Class” field.

*  Hold down the <Ctrl> key and click the
“Description” field. Your selection should look like
this:

...... I:IESS

Fields for Class

M arne | Tope | Size |
String 3
String 20

(A Locked Boole. .

Data I Layout I

*  Locate the divider labeled “Detail” on the canvas of
the design workspace.

*  Place the mouse cursor over the divider. The cursor
will change to an up/down arrow.

* Increase the height of the detail band to 1 inch by
dragging the divider down and referring the vertical
ruler to the left.

*  Position the mouse cursor over the “Class” field in
the Data Tree and drag the selection into the detail
band.

*  Release the mouse button. The components necessary
to display the “Class” and “Description” fields in the
report are created.

* Header

- Class | BSH |
~ Description!i&irship I

*  Click on the Preview tab. Notice how the labels
repeat for each row of the data. This is called a
vertical report because the components are laid out in
a top-to-bottom fashion.

Task 5: Create a tabular report

*  Return to the design workspace.

*  Select all of the components and press the <Delete>
key.

*  Click on the Layout tab at the bottom of the Data
Tree.

*  Select the “Tabular” style.
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Click on the Font button i in the Labels section.

The Font dialog box will appear.

Font: Fant style: °
IE IHeguIar .
-
Aiial Black 1 |Italic .
B Avial Marmow Bold
H BarkGothic Lt BT Buold [talic
B BarkGothic Md BT
BinrerD
B Bock Artiqua ﬂ
— Effect — Sample .
[T Strikecut
[ Undeine AaBbeZZ
Color:
I- Black - I Script:
L]
|Western LI

Thig iz an DpenT ype font. This zame font will be used on both your
printer and wour screen,

Make the Font style Bold. Now any label created via
the Data Tree will be bold.

Click the OK button on the Font dialog. Notice how
the diagram at the top of the Data Tree reflects the
change by bolding the word “Company”.

Click on the Data tab at the bottom of the Data Tree.
Verify that both the “Class” and the “Description”
fields are selected. If not, select them — “Class” field
first, then “Description”.

Position the mouse cursor over the “Class” field in
the Data Tree and drag the selection into the lower
left corner of the header band.

Release the mouse button. The components necessary
to display the “Class” and “Description” fields are
created. The Label components are added to the
header band and the DBText components to the

detail band.
D"'I"'l"'l"'l"'l" *
_EI
- Class |Description |
” Header
=% Class |Description |

Click on the Preview tab. Notice how the labels
appear only once at the top of the page. This report is
“tabular” because the data is laid out in a left-to-right
fashion.

Task 6: Create a tabular report with a grid .

Return to the design workspace and delete all of the
components.

Click on the Layout tab at the bottom of the Data
Tree.

Click the Grid check box for both Labels and Fields.
Click on the Data tab at the bottom of the Data Tree.
Verify that both the “Class” and the “Description”
fields are selected. If not, select them — “Class” field
first, then “Description”.

Position the mouse cursor over the “Class” field in
the Data Tree and drag the selection into the lower
left corner of the header band.

Release the mouse button. Notice the boxes around
the components. These shapes will give us the effect

of a grid.
IClass ﬂDescription |
" Header
Class WDescription |
* Detail

Use the bounding box method to select all of the
components in the header band.

[T —— [Description ]
Header
Class WDescription |

Remove the labels from the selection by holding
down the <Shift> key and clicking on each label.
Only the shapes should now be selected.

Locate the Fill Color button EH on the toolbar

and select Light Gray.
Drag the divider labeled “Detail” up until it meets the
bottom of the components in the detail band.

R L R

_ o

- [Class [Description |
* Header

- Class [Description |
* Detail

o

Click on the Preview tab. Notice the grid effect.
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Data | Calc | Design PfEViEWl

& DBEEBE [2=x 4 4 [

Class Description
LsH Airship

BAL Ealloon

YR Syrocopter

HLTC Helicopter

MEL Multi-Engine Land
MES Multi-Engine Sea
A {not applicable)
SEL Single-Engine Lar
SES Single-Engine Se;

*  Save the report as Cal-2 and close the Report
Designer.
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Summary Tutorial

OVERVIEW
This tutorial will solidify all of the report-building

techniques you learned in Calisthenics. The final report

for this tutorial should contain a list of flights including:

The departure date,

the route (From, To & Via),
the flight duration (block-time),
the type-of-time, and

the number of landings.

Dep Date Route
071171985 KITMNKMIV K17N 084 91N
071771885  KIN4K17TN 0:24 81N
071771885 KIN4 KIN4 118 91N
071771885 KI1TMNKIN4 0:18 81N
07231985 KITNKITH 0:36 91N

Block Time Type Landing:

s

4

1

2

1

1

07/24718985  KITNKMIV 17N 100 91N 6

07/20/1985  KITNKNBT KI7N 042 91N 2

08/01/1985  KITNKNBTKITN 0:30 91N 2

080211985 KITNKITH 048 91N 6

08/05/1985  KITNKITN 0:36 91N 4

08/13/1985  KITNKITM 048 91N 2

08181985 KITNKITH 0:42 91N 2

08/27/1985  KITNKITN 0:38 91N 1

09/03/1985  KITNKITH 0:48 91N 4

08/15/1985  KITNKEVY KITN 136 81N 2
QUERY WIZARD

Start AeroLog Pro and click the Custom Reports
button.

Click the New Reportg button in the navigator

bar.

Click on the Data tab.

Select [File[New] from the menu.

Double-click on the Query Wizard icon. The Query
Wizard will come up with a list of Available Tables.
Choose the PilotLog table by double-clicking on it.
Confirm your selection by verifying that the table
name appears in the Selected Tables list.

Click the Next button. Keep clicking Next until you
reach the Set Order page.

Click on the Set Order button.

Double-click on PilotLog.Dep_Date so it appears in
the Selected Fields list.

Click Next. A screen with a checkered racing flag
will appear.

Select the Preview radio button near the bottom, then
click Finish. A Data Preview screen will appear
listing information from the PilotLog table.

Click OK.

—Create Style

e Al ITaI:quar - I

—{" Labels
[T Gnd Fort A
—{" Fields

™ Grid

Select the Design tab.

DESIGN WORKSPACE

Task 1: Set the Data Tree properties

If it is not already visible, launch the Data Tree
toolbar.

Dock it on the left side of the workspace.

Click the Layout tab of the Data Tree.

Set the Style to “Tabular”, and deselect the Grid
boxes if they are checked.

Click the Font button in the Labels section and set it
to Arial, Bold, 10.

Click the Font button in the Fields section and set it
to Arial, Regular, 10.

Click on the Data tab of the Data Tree.

Press <Ctrl-S> to save your work. Save the report as
“Summary Tutorial”. Repeat the save after
completing each task.

Task 2: Create the components

Place the mouse cursor over the “Detail” divider and
drag it down until the detail band is 1-inch high.
Place a Shape component in the detail band.

'& -
Set the shape's fill color—|—| to yellow, and line

-
color —|—| to white.

Right-click over the shape and select ParentHeight
and ParentWidth.

Hold down the <Ctrl> key while you select the “Dep
Date”, “Route”, ““Block Time”, “Type of Time” and
“Landings” fields (the order matters) in the Data
Tree.

Drag the selection from the Data Tree into the lower
left corner of the header band and release the mouse
button. Label components will be created in the
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header band and DBText components in the detail
band.

ot [T R T T T BT o T

o

- Dep Date | Route | Block Time [Type Of Time |Landings |
* Header

-° Dep Date |Route | Block Time |Type OiTime  ]Landings |

Task 3: Position, size and align components
*  Select both the “Dep Date” Label and the “Dep
Date” DBText components.

*  Click on the Center Justify button % .

*  Deselect all components by clicking in the footer
band.

e Select the “Block Time” Label, “Block Time”
DBText, “Landings” Label, and “Landings” DBText.

«  Click on the Right Justify button .= = | == — |
[ _DepDate |Route Il Block Time|Type Of Time || Landings]
* Header

[ Dep Date Route I Block Timel Type Of Time | Landings

*  Right-click over the “Block Time” label and select
AutoSize.

*  Set AutoSize for the “Type of Time” and “Landings’
labels.

il

[ _DepDate |Route | [Block Tim¢ Type Of Time]
* Headst
[ DepDate Route [ Block Time [Type Of Time| [ Landingg

*  Change the “Type Of Time” label caption to “Type”.
¢ Select the “Block Time” label, then shift-click and
select the “Block Time” DBText.

o
[ =

«  Click the Shrink Width to Smallest button _*_. The
DBText width should now match the label above.

*  Click the Align Left button = align the two

components vertically.

*  Shrink the “Type Of Time” DBText component to
match the width of the label above.

*  Shrink and align the “Landings” DBText component
to match the width and position of the label above.

[_DepDate |Route | [Block Timg|
* Header
[ DepDate |Route ] [Block Timd [Tupe]|

¢ Select the “Block Time” Label, “Block Time”
DBText, “Type” Label, and “Type Of Time”
DBText.

*  Drag the selection to the right until the left guide is at
the 4.25" mark on the horizontal ruler above.

»  Select the “Route” label then resize it by dragging the
right edge to the right until the guide reaches the 4"
mark.

L e - A T R

Dep Date Route

" Header

[ DepDate |Route J

Block Timél[fypel  Landings|

I Block Time!ifvpe!  [Landingd

¢ Shift click on the “Route” DBText then click the

=
(=]

Grow Width To Largest button -—*_. The DBText
should expand to match the width of the label.

P L P P P B P |

[ DepDate  |Route ] [BlockTimg[Typg [andings
* Header
[_DepDate _ |Route T [Elock Timd Type] Landingd

*  Select the “Type” Label and the “Type of Time”
DBText components.

*  Hold down the <Ctrl> key and tap the right arrow
key until the components are approximately centered
between the Block Time and the Landings columns.

LR T S . S S

Dep Date | Route ] [Block Time Landings
" Header
[ DepDate  |Route | [BlockTimd [Type] [LCandingd

Task 4: Set display formats and size detail band
* Right-click over the “Block Time” DBText and select

ElapsedTimeFormat

*  Drag the detail band divider up until it meets the
bottom of the components.
Task 6: Lay out the Footer band

*  Click the System Variable button @

¢ Click the lower left side of the footer band to create

the new System Variable component.

*  Select “PrintDateTime” from the drop-down list box
in the upper left corner of the workspace. The date
and time should appear in the component.

*  Place another System Variable component in the

lower right side of the footer band.



*  Select “PageNoDesc” (Page Number Description)
from the drop-down list box. The page number
should appear in the component.

*  Right justify the page number system variable by
clicking the right-justify button =

*  Align the tops of the system variables.

Dn""“‘\V“"“\Z““"‘a““"'\n“““' I’ !

- [_DepDate Route | [BlockTimg [andings

-+ [_DopDale IRolfo ] [BlockTimd [Type] [Landingd

Press <Ctrl-S> to save your work.

PREVIEW
Click on the Preview tab and look at your report. It
should look this:

Dep Dok
7111585
mHTiEEs
mHTiEEs
O/ 17i1585
M/Z0es
/2w 1585
O /2N 1525
ET1i1EEs
B 15Es
EDS 15E5
E13EEs
E1EEEs
[E/Z7i1585
[EMEEs
[EV 151585
[EV15/1585
[EV1Ti 1585
[EVIE1EEs
[EVEN 1585
10DSMEEs
AT
1VIE15ES
11BN 1585
117111588
111585
1ZMEN 1EEs
1ZEE1EEs
171 1=Es
Oi/Z31585
121585
[OTEN 1585
O«T1i1585
O+ZE 1585
O131585
DSTIE1EE5
DSZ71EE5
/isas
O & 1585
M w15e5
/Z&1585
/AN 1585
[EDS 1585
E 1585
251585
[EVIE/ 1585
DM 5E5
0iS15E5

N 17 e

Fout
KATH KM EATH
EiN+KiTH
EiN+Kil+

KATH KN e

KATH KATNH

KATH KIS EATH
K1TH KNE1,EITH
K1TH KNE1EITH
EATHLEITH
EITHLEITH

EATH K1TH

EATH KiTH
KATHKATH

KATH KATH

KATN KEWY EATH
KATHKATH

K1TH KT

EATH KiTH
KATHLEITH

KATH KTHU,EATH
EATH KiTH
KATHKATH
KATHKATH
KATHKATH

KATN KEWY,EATH
E1THEITH
K1THEITH
KITHLEITH

KATH KATH

EATH KiTH

KATH KIS EATH
KATHKATH
EATHEITH
KATHKATH
EATHLEITH
K1THEITH

EATH K250 E1TH
KATHKATH

KATH KATH

KAT N KIS, EATH
EATH KN KITH
KATHEITH
KATH, KELMEATH
EATHLEITH
K1THEITH

EATH KFD K ELNE EATH
EATH KiTH

Elooh Time
o=+
02+
142
o=
035
im
Oz

Toe
=31
=]
E]
]
N
=M
BN
]
=1M
]
=]
E]
]
N
]
EN]
=]
=]
=1M
=]
]
]
EN]
3]
EN]
BN
]
=1M
=]
]
]
EN]
BN
]
BN
]
=iN
]
N
]
EN]
BN
]
BN
]
=]
E]

Landing &

LIl s M= IR DLW R = the o ep s bl hls e bl = hh e = R D BB 0 == b=

Close the Report Designer, saving the changes to the

report.
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Cover Page

OVERVIEW
This tutorial shows you how to create a cover page for a

report. The final product will contain the title of the report

and a description of the contents of the report.

DESIGN WORKSPACE

Task 1: Create and adjust the Title band

Open the Summary Tutorial report by selecting in the

Custom Report Explorer window, then clicking the

Open Report button E

Select [File|Save As] from the main menu of the
Report Designer.

Name the report “Cover Page” and click Save. The
name at the top of the Report Designer should change
to “Cover Page”.

Hide the Data Tree if it is visible.

Select [Report|Title] from the menu. A title band will
appear at the top of the canvas.

Increase the height of the title band by dragging the
divider down until the guide reaches the 9 2 inch
mark on the vertical ruler.

Task 2: Create a Shape and a Label

Place a shape in the upper left corner of the title
band.

Set the position of the shape to: Left= 2.0, Top= 2.5,
Width= 4.0 and Height= 1.

Set the fill and line color of the shape to light gray.
Place a label over the shape.

Set the caption to “Flight Listing”.

Set the font size to 28.

Set the justification to left .

Select the shape and then shift-click the label.

Click the Align Center button ﬂ and the Align

Middle button E The label should be centered in
the middle of the shape like this:

Flight Listing

Task 3: Create and adjust a shape

Place a new shape below the existing shape. Set the
position of the shape to: Left= 2.0, Top= 4.0, Width=
4.0 and Height=3.3.

Set the line color of the shape to dark gray.

Task 4: Create and adjust labels

Create four labels and place them over the shape.
Set the caption for each label as follows:

Label7: “Departure Date”

Label8: “Route”

Label9: “Block Time”

Label10: “Landings”

Select the labels and set the font size to 22. The title
page should look like this:

Departure Date

Route

Block Time
Landings

Select the “Flight Listing” label and then shift-click
the “Departure Date” label.

Click the Align Middle button i

Set the top of the “Departure Date” label to 4.75.

Set the top of the “Landings” label to 6.5.

Select the “Departure Date” label and then shift-click
the three labels below it.



22

*  Click the Left Align button 1= and the Space

Vertically button ﬂ The selection should now
look like this.

Departure Date

Route

Block Time

Landings

PREVIEW
*  Click the Preview tab. The title page should look like
this:

Flight Listing

Departure Date
Route

Block Time
Landings

T na Fagu 1

*  Click the Next Page button to view the body of the
report, which should be the same as the Summary
Report from the last chapter.

*  Close the Report Designer and save the changes.
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Simple Table Listing

OVERVIEW
This tutorial illustrates how to create a tabular flight
listing which includes aircraft information linked-in

(joined) from a separate database table. The resulting

Report Wizard

Select the following fields by double-clicking: Acft
ID, Acft Type, Dep Date and Block Time.
Click Next until you see the screen with the

checkered racing flag. Select “Modify the report's
design”.

report will include:

The aircraft ID (“N” number),

The aircraft type,

The departure date of the flight, and
The duration of the flight (block time).

QUERY WIZARD
Task 1: Create the Dataset

Create a new report.

Select the Data workspace.

Select [FileNew...] then select the Query Wizard.
Select (double-click on) the Aircraft table.

Select the PilotLog table.

Click Next until you reach the Set Order screen.
Click “Set Order” and select Aircraft. Acft ID and
PilotLog.Dep Date.

Click Next and then Finish to complete the query.

If the preview data screen appears, click OK to close
it.

Select the Design workspace.

DESIGN WORKSPACE

Task 1: Create a layout using the Report Wizard
Select [File[New...] then double-click the Report
Wizard icon.

New Items il

o)

Repart Label
Templates

] I Cancel

That iz all the information needed to create your report

Do you want to preview the report of madify the iepart's
design?

= Preview the report

Cancel | < Back | [t | Finish

*  Click Finish. The report layout will appear.

R TR S L N P I ST AR L

e
O
- New Report

“ Title

-" Wgrra] Wcr Type| Bep Dute] Block Time]

° Header
B —. Deplate | Block Tie |
* Detal

-° [erazo0l 1 Fage |

“ Footer

*  Press <Ctrl-S> and save the report as “Simple
Table”.

Task 2: Fine tune the components

*  Right-click over the “New Report” label in the
header band and select AutoSize.

*  Select the “New Report” label and set the caption to
“Flight Detail by Aircraft”.

*  Select the “Block Time” label and set the caption to
“Duration”.

»  Shift-click the “Block Time” DBText then click the

Right Justify button . — — I"™= = |
*  Right-click over the “Block Time” label and select
AutoSize.

a
C:

«  Click the Shrink Width To Smallest button __*_ and

the Align Left button I_E

*  Right-click over the “Block Time” DBText then
select ElapsedTimeFormat.

*  Save the report then click the Preview tab.
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Flight Details by Aircraft

Acftid  Acft Type Dep Date Duretion
LMK GO 072452001 112
ME7314 CESSMA -1 035311991 7400
MTS06S CESSMA C-1% 035311991 129:00
P27 3N CESSMA 1720 0355311991 19:00
M29577 CESSMA C-20 03755311991 17:00
M98330 CESSMA C-20 03755311991 Fa:00
M45157 CESSMA C-27 035311991 345:45
M45157 CESSMA C-27 090301992 0:42
M45157 CESSMA C-27 10/09/1992 1:00
M45157 CESSMA C-27 10/5M1992 4:45
M45157 CESSMA C-27 097221995 418
M45157 CESSMA C-27 0972451995 300
M3157 CESSMA -2 09/25M 998 0:42

Task 3: Layout corrections

As you can see, there are a couple of problems. Notice

that the Acft Type column is not wide enough to show the

full aircraft type. Also, notice how the repetition in both
the Acft ID and Acft Type columns. Let’s fix these.

Select the Design workspace.
Select the “Dep Date” label, then shift-click the “Dep
Date” DBText.

Click the Nudge Right button ﬂ several times until
the selected Label and DBText components are about
1/8 inch from the Duration column.

Right-click over the “Acft Type” DBText, select
Position... and set the Width to 0.8.

Right-click over the “Acft ID” DBText and select
SuppressRepeatedValues. Do the same for the “Acft
Type” DBText.

Click the Preview tab. The aircraft ID and aircraft
type columns should no longer show repeated values.

>

Click the Next Page button a few times and

notice that there is no aircraft ID or aircraft type on
the first line of some pages. Because these columns
do not repeat values it is difficult to tell the aircraft
used for these flights without looking on the
preceeding page(s). Fortunately this is easy to fix.

Task 4: Additional corrections

Right-click over the “Acft ID” DBText component
and select ReprintOnSubsequent.

Right-click over the “Acft Type” DBText component
and select ReprintOnSubsequent.
Click the Preview tab.

>

Click the Next Page button a few times and
notice that the aircraft ID and type are always shown

on the first line of a new page.

Task S: Create a line guide

Notice that the ReprintOnSubsequent option creates a

lot of white space, making it difficult to read.
Return to the design workspace.

Click on the Line button J .

Click in the detail band to create the Line component.
Right-click over the line and select ParentWidth. The
line will stretch to match the width of the band.
Right-click over the line, select Position... and set
Top to 0.15.

Save the report then click the Preview tab.

Flight Details by Aircraft

Aeftid Acfi Type  Dep Date Duration
LINK GHD 07242001 1:12
HET31< CESSHA C-152 034311991 400
N7O0G2 CESSHA CATZ 02/21M991 129:00
MNSZ2T 3 CESSHA ITZRG 0373111991 19:00
N29277 CESSHA C-207 02/21M991 1700
H29330 CESSHA C-205 0353101991 FE:00
Na2157 CESSHA C-210 02/21M991 248498
09,30/ 992 092
10094992 1:00
1015992 443
Q220092 412
09,24 993 200
0925092 0:.42
MM FITTS SPECL 03/31M11991 G:00
N2262H PA-181-28 03:3101991 G100
H2G6860 CESSHA C-310 0352311991 13:00

Close the Report Designer.
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Flights Grouped By Aircraft

OVERVIEW

This tutorial illustrates how to create a flight listing which
is grouped and sub-totaled by aircraft. It also illustrates
how to import and use a saved DataView.

The resulting report will include grouped listings of
flights by aircraft ID. Each group will have a header area
showing the aircraft ID, and a summary (footer) area
showing the total number of flights and the total duration
of the flights in that aircraft. Details for each group will
include:

*  The departure date of each flight,

*  The route of each flight, and

*  The duration of each flight (block time).

DATA WORKSPACE

As is often the case, several reports may have Datasets
which are identical, or almost so. To save time and effort,
the Report Designer allows you to save (“export™) a
Dataset as a separate entity (called a “DataView”), and
then “import” it into the Data Workspace of another
report.

In the previous tutorials, you use the Query Wizard to
create the Dataset for each report from scratch. For this
report, you will be importing a previously-saved
Dataview called Flights By Aircraft.

Task 1: Import the Dataview

*  Create a new report.

*  Select the Data workspace.

*  Select [File[Import...].

*  Locate and open the Dataviews folder then select and
open Flights By Aircraft. The Data workspace will

appear as shown below.
*  Select the Design workspace.

R Custom Report: Hew Report

File

Data |Ea||: I De&ignl F'reviewl

A E20E T Q& 7| 3
M arine | Type | Size | -
Pilat Ha Sting 15

Dep Date Date

Acft Tope Stiing 12

Categon String 3

Clazs Stiing 3

Acft1d Stiing 12

Fram Stiing 10

To String 10 b
Yia Stiing 30

Block Time Inteqer

Ifr Actual Inteqger

Ifr Hood Integer

Approaches |nteqer

Mimht ltener LI

DESIGN WORKSPACE

Task 1: Create the layout using the Report Wizard

*  Select [File[New...] then double-click the Report
Wizard icon.

*  Select the following fields, in the order shown, for
the report: Pilot No, Acft Id, Dep Date, From, To,
and Block Time.

*  Click the Next button.

*  Select the Pilot No field as the first group, and the
Acft ID field as the second group.

Available Fields

|DBE Do |Pilot No

|Ac[l Id

Dep Date, Block Time

Groups _I" _I"

Filat Mo

Ackt Id
]
Friority
]

*  Click the Next button.

*  Select the “Outline 1" Layout, then click the Next
button.

*  Select the “Corporate” Style, then click the Next
button.
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e Select “Modify the report’s design” then click the

Finish button. The layout should appears as shown NEW Rep o rf
below. -
John Price
o i g ’ 3457H
[ NE'.'W Rep(}}‘t Dep Date  From To Duration
~ Tl 111041995  PHE PHE 2:45
Header AN
_ 0 133456720
" Group Header[0]; Filat Mo Dep Date  From To Duration
| 1000 021031995 MGk hAGh 0:00
[ Dep Date | From | [To] | Block Time] 4o
" Group Header[1]; Acft 1d <
o Ak | BAR 1 o Dep Date  From To Duration
“ Detai 030951954 O2R LCL 1:00
" Group Footer|1]: Act Id 08M0M934  0O2R LCL 212
" Group Foaoter[Q]: Filat Mo
- FeTmnL 1 081141994  0O2R Ll 245
T~ Footer 05424994 02R LeL 2:30
05151994 02R Ll 230
*  Save the report, changing the name to “Flights
08161994 0ZR Ll 254

Grouped by Aircraft.”

Task 2: Clean up the layout.

A couple of minor adjustments are needed before this

report is complete.

*  Select the Pilot No component in the Group
Header[0] band.

* In the Edit Toolbar, change the field name from
“Pilot No” to “Name”.

*  Change the “Block Time” Label in the Group
Header[1] band to “Duration.”

*  Select the Block Time component in the Detail band

then click Right-Justify — = ™= =

* Right-click on the Block Time component, then
select “Elapsed Time Format” from the menu.

*  Save the report layout, then click the Preview tab.



